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they provide important hints for use and maintenance safety. 

• The software described in this manual is a tool helping device control. Enertronica Santerno S.p.A. is not 

responsible for any direct and/or consequential damages due to the implementation of the Remote 

Sunway. 

• Enertronica Santerno S.p.A. reserves the right to make any technical changes to this manual and to the 

device without prior notice. If printing errors or similar are detected, corrections will be included in the 

new releases of this manual. 

• Enertronica Santerno S.p.A. is responsible for the information contained in the original version of the 

Italian manual. 

• The information contained herein is the property of Enertronica Santerno S.p.A. and cannot be 

reproduced.  Enertronica Santerno S.p.A. enforces its rights on the drawings and catalogues according to 

the law. 
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1. OVERVIEW 

 

This manual contains the instructions required for properly installing and starting the supervisor system for the 

inverters manufactured by Enertronica Santerno S.p.A.. 

 

The Remote Sunway is a PC software application running on Windows
TM

.
 
The Remote Sunway makes it 

possible to manage Santerno inverters both in local mode, via the MODBUS protocol on RS232C, RS422 and 

RS485 serial communications, and in remote mode via TCP/IP protocol. 

Being very versatile, the Remote Sunway quickly and efficiently sets and stores to file the whole parameter set 

of the connected device; manages the remote monitoring data; manages the firmware upgrade. 

Also, the Remote Sunway may acquire, graphically represent and store to file all the variables that can be 

detected by the connected device. 

 

 

NOTE 

When the supervisor computer is operating as a data logger, this must be kept 

constantly on-line with the inverter(s) to be monitored. We recommend that a 

standard desk UPS be used for supplying the supervisor computer, thus avoiding 

faults due to mains failure. 

 

Please refer to the MODBUS Manuals—when available—pertaining to each device for the description of the 

MODBUS protocol, the list of the parameters that can be exchanged and the relevant addresses. More details 

are also given in the User Manuals of the connected devices. 

 

 

NOTE 

The Remote Sunway is capable of managing any SW version prior to the latest SW 

version installed on the device by loading the configuration files stored in the 

\Devices folder of the Remote Sunway. 

 

 

 

NOTE 

The Remote Sunway is capable of managing SW Versions higher than the versions 

installed. Different devices may be managed by adding a configuration file for each 

of them to the \Devices folder in the Remote Sunway. 

The configuration files are available from santerno.com or may be required to the 

Customer Service of Enertronica Santerno S.p.A.. 

 

http://santerno.com/
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2. TECHNICAL  FEATURES 

 

2.1. Minimum Installation Requirements 

The same requirements as per a laptop allowing Internet navigation are needed. 

 

2.1.1. MINIMUM HARDWARE REQUIREMENTS 

 

• Pentium 1GHz or greater 

• RAM >= 256Mb for Windows 2000, 512 Mb for Windows XP and 1Gb for Vista 

• CD-ROM player 

• Modem or network card (depending on the type of remote connection to be established) 

• At least 1 serial port or USB port 

• Video card and monitor able to support 800x600 display resolution 

 

2.1.2. MINIMUM SOFTWARE REQUIREMENTS 

 

• Operating system: Windows
TM

 NT4, 2000, XP, Vista, 7 

• When using Windows NT4, Internet Explorer 5.00 or greater must be installed 

 

2.2. Items Supplied 

 

The Remote Sunway is supplied on a CD-ROM including a wizard for installation to hard disk. 

 

2.3. Operational Features 

 

The Remote Sunway supports two operating modes: Local mode and Remote mode. 

• In “Local” mode, the PC is connected directly to the device. 

• In “Remote” mode, two options are available.  

1. Two computers can be connected to each other via the telephone line, via a LAN or via the 

Internet. The Remote Sunway must be installed and running on both computers. The 

equipment must be connected to the serial port of one computer, which is the slave computer. 

The master computer handles the equipment through the slave, and is capable of fully 

exploiting functionality just as if the equipment was connected to the serial port of the master 

computer. While connected, a chat window is also displayed for the users of the two 

computers. 

 

2. A computer using the Remote Sunway can be connected to a computer equipped with ES851 

Data Logger. The Data Logger is the server, whereas the computer connected to it via the 

telephone line, the LAN or the Internet is the master computer, thus allowing the Remote 

Sunway to monitor both ES851 Data Logger and all its connected devices. 

 

 

The remote connection uses TCP/IP-based Winsock services; the dialogue is made possible through TCP and 

UDP packets via the same port as mentioned in STARTING AND CONFIGURING THE PROGRAM.  

Connecting examples are given below. 
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2.3.1. LOCAL CONNECTION 

 

 

The computer is connected directly to the devices by means of an RS232 serial cable or USB/485 adapter. If 

ES851 Data Logger is installed on the devices, the local connection is made possible through the serial ports 

in ES851 (RS232 or RS485 ports) or through the Ethernet port in ES851 and a crossed-over Ethernet cable. 

 

2.3.2. REMOTE CONNECTION VIA THE LAN  BETWEEN 2 

COMPUTERS 

 

 

The devices can be remote-controlled via the Local Area Network of your company. 

The LAN must support the TCP/IP protocol. 

 

2.3.3. REMOTE CONNECTION VIA THE LAN AND THE INTERNET 

BETWEEN 2 COMPUTERS  

 

 

The devices located even at a long distance from the supervisor computer may be monitored via the Internet at 

reasonable costs. 

When accessing the Internet via Firewall or Proxy server, make sure that the port used for the Remote Sunway 

is activated.  

 

 

2.3.4. REMOTE CONNECTION VIA THE INTERNET BETWEEN 2 

COMPUTERS 

 

The Internet allows the remote control of long-distance connections at a relatively low cost. 

If you access the Internet through a firewall or a proxy server, remember to enable the port used for the 

Remote Sunway. 

 

 

NOTE 

When using the remote control services provided from Enertronica Santerno 

S.p.A., the Internet connection must be established using the 

link.elettronicasanterno.it Proxy server (see the Connection via the Internet 

section). 

 

   Devices 

PC (Local) 

Serial Cable 

PC (Master) 

   Devices 

 

Serial Cable 

PC (Slave) 

LAN 

PC (Master) 

   Devices 

 

Serial Cable 

PC (Slave) 

Phone Line Phone 

Line 
Internet 

PC (Master) 

Devices Serial Cable 

PC (Slave) 

LAN LAN 

Internet 

file://///Essrv01/manuali_tecnici/REVISIONE_RICERCA/MANUALI%20IN%20AGGIORNAMENTO/REMOTE%20SUNWAY%20HTML/UK/08_04_10/400_proc_di_connessione.htm%2345000
file://///Essrv01/manuali_tecnici/REVISIONE_RICERCA/MANUALI%20IN%20AGGIORNAMENTO/REMOTE%20SUNWAY%20HTML/UK/08_04_10/400_proc_di_connessione.htm%2345000
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2.3.5. MODEM POINT-TO-POINT CONNECTION VIA THE 

TELEPHONE L INE BETWEEN 2 COMPUTERS 

 

 

This type of connection may be adopted if no Internet connection is available or if the connection to the 

Internet is too slow (see Configuring the Operating System for Point-to-Point Connections). 

The Remote Access Server receiving the call shall be enabled. 

 

 

2.3.6. REMOTE CONNECTION VIA THE LAN  BETWEEN THE 

COMPUTER AND THE DEVICE IMPLEMENTING ES851   

 

2.3.7. REMOTE MODEM CONNECTION VIA THE TELEPHONE LINE 

BETWEEN THE COMPUTER AND THE DEVICE IMPLEMENTING 

ES851 

 

 

ES851 

 
PC (Master) 

    Device with ES851 (slave) 

 

Multidrop networked devices 

 

Phone Line 

LAN 

ES851

1 

 
PC (Master) 

  Device with ES851 (slave) 

 

Multidrop networked devices 

 

PC (Master) 

Devices Serial Cable 

PC (Slave) 

Phone Line 
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2.3.8. REMOTE CONNECTION BETWEEN THE COMPUTER AND THE 

INVERTER IMPLEMENTING ES851  VIA THE INTERNET 

USING THE LINK.ELETTRONICASANTERNO.IT PROXY 

SERVER 

 

 
 

 

NOTE 

This type of connection allows connecting the plant via the Internet using the 

services provided from the link.elettronicasanterno.it Proxy server (see the 

Connection via the Internet section). 

 

 

file://///Essrv01/manuali_tecnici/REVISIONE_RICERCA/MANUALI%20IN%20AGGIORNAMENTO/REMOTE%20SUNWAY%20HTML/UK/08_04_10/400_proc_di_connessione.htm%2345000
file://///Essrv01/manuali_tecnici/REVISIONE_RICERCA/MANUALI%20IN%20AGGIORNAMENTO/REMOTE%20SUNWAY%20HTML/UK/08_04_10/400_proc_di_connessione.htm%2345000
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3. ELECTRICAL  CONNECTIONS 

3.1. Connecting the Slave Devices Included in the 

Photovoltaic Plant 

 

Applicable slave devices: 

Sunway TG 

Sunway TG TE 

Sunway M XR 

Sunway M PLUS 

Smart String Box 

 

These devices can be connected directly to a computer implementing the Remote Sunway (local connection), or 

to an ES851 Data Logger board installed on one of the devices. Either in local mode or in remote mode, the 

Data Logger can then be connected to a computer implementing the Remote Sunway. 

 

3.1.1. SUNWAY TG AND SUNWAY TG TE 

 

Terminal board X4 

RS485 RX/TX  

A+ 

RS485 RX/TX  

B- 

RS485 Common 

0V 

01 02 03 

 

 

The terminal board X4 allows connecting the Sunway TG through its slave RS485 serial port (the layout and 

the location of the terminal board depends on the inverter model; normally, the terminal board is located on 

one side of the cabinet). 

 

The terminators/polarisers, which are normally “ON”, are located on the serial communications board 

installed on the converter module (inverter). 

 

 

NOTE 
If multiple inverters are connected, terminators must be set to ON in one device 

only. 

 

To gain access to the terminators, open the front door on the inverter module. 

 

 

DANGER 

Before operating inside the inverter, remove voltage and wait at least 10 

minutes. Electrical shock hazard exists even when the inverter is not powered on 

until the capacitors have completely discharged. 

 

CAUTION 

Do not connect or disconnect the signal terminals or the power terminals when 

the inverter is on. Electrical hazard exists; also, the inverter could be seriously 

damaged. 

 

 

For more details, please refer to the Installation Instructions manual of the product. 
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3.1.2. SUNWAY M XR  AND SUNWAY M PLUS 

Slave RS485 plug is replicated to a 9-pin D connector, which is located on the lower part of the inverter frame. 

(A flying connector is also supplied, which maintains the IP65 degree of protection.) 

 

CN1 

RS485 

RX/TX  

A+ 

RS485 

RX/TX  

B- 

RS485 

RX/TX  

A+ 

RS485 

RX/TX  

B- 

RS485 

0V 
+8V Ext NC NC +5V 

01 02 03 04 05 06 07 08 09 

 

 

 

 

NOTE In multi-inverter plants, terminators must be set to ON for the farthest device only. 

 

To gain access to the terminators, remove both the external polished cover and the internal water-tight cover. 

The terminators are located on ES821 control board. 

 

 

DANGER 

Before operating inside the inverter, remove voltage and wait at least 10 

minutes. Electrical shock hazard exists even when the inverter is not powered on 

until the capacitors have completely discharged. 

 

CAUTION 

Do not connect or disconnect the signal terminals or the power terminals when 

the inverter is on. Electrical hazard exists; also, the inverter could be seriously 

damaged. 

 

For more details, please refer to the Installation and Programming Instructions manual of the product. 
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3.1.3. SMART STRING BOX 

 

When connecting a Smart String Box to RS485 serial network, use the screw connector (M11) and the CN3 D9 

connector. M11 connector is available for the connection to RS485 serial network; CN3 connector is used for 

the internal connection of multiple 8-string modular units. The connection cable is supplied from Enertronica 

Santerno S.p.A.. For more details, please refer to the User Manual of the Smart String Box. 

 

 

NOTE 

Every Smart Junction Box (8-string module) is a node in the RS485 network. 

Because each CS-SP-24-XXXV consists in three modules, it is considered as 

forming three different nodes in the RS485 network. 

 

 

Terminal board M11 

RS485 

RX/TX  

A+ 

RS485 

RX/TX  

B- 

+5V out 
RS485 

0V 

+10V 

I/O 
PE Shield 

07 08 09 10 11 12 

 

 

D9 CN3 Connector 

RS485 

RX/TX  

A+ 

RS485 

RX/TX  

B- 

RS485 

RX/TX  

A+ 

RS485 

RX/TX  

B- 

RS485 

0V 
+8V Ext 

RS485 

0V 

RS485 

0V 
+5V 

01 02 03 04 05 06 07 08 09 

 

 

 

 

NOTE 
The screen for the interconnection cable between the modules is connected to the 

connector case. 
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The Smart String Boxes must be cascade-connected to RS485 serial link (star connections are to be avoided). If 

including multiple 8-input modules (up to three modules), these must be cascade-connected using the special 

cable supplied (cable 2 or cable 3). 

 

Once the modules are interconnected (no interconnection is required for CS-SP(A)-8-XXXV), link the incoming 

RS485 serial link to the screwable terminal board (M11) in the first module. For CS-SP(A)-8-XXXV, the 

outcoming RS485 serial link comes from M11 terminal board; otherwise, the outcoming RS485 serial link 

comes from the farthest M11 terminal board. 

 

 

NOTE 
The terminator for RS485 serial link must be plugged into the farthest module in 

the line. 

 

For more details, please refer to the Installation Instructions manual of the product. 
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3.2. Connecting ES851 Data Logger Board 

 

The external devices that can be connected to the Data Logger Board are the following: 

Sunway TG 

Sunway TG TE 

Sunway M XR 

Sunway M PLUS 

Smart String Box  

 

For more details, please refer to the Installation Instructions manual of the product. 

 

3.2.1. LOCAL CONNECTIONS 

 

The Data Logger board is provided with N.2 COM ports for the local serial connection.  

 

COM1 Port 

 

The COM1 port may be accessed from a DB9 male connector connected to the board by means of a flat 

cable supplied with the Data Logger board.  

The COM1 port may support either RS232 or RS485 protocol. 

 

 

CAUTION 

The COM1 port may support RS485 protocol starting from ES851/1 version 

only. For ES851/0 boards, the COM1 port acknowledges the RS232 standard 

only. 

 

 

COM1 RS232 

 

The factory setting for the COM1 port is slave Modbus RS232 communications standard. This makes possible 

to connect the PC to the plant by means of the null modem cable using the COM1 port of the Data Logger 

board and the COM port of the PC. 

 

Pin Function 

1 CD – Carrier Detect 

2 RD – Received Data 

3 TD – Transmitted Data 

4 DTR – Data Terminal Ready 

5 GND – Ground 

6 DSR – Data Set Ready 

7 RTS – Request To Send 

8 CST – Clear To Send 

9 RI – Ring Indicator 
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COM1 RS485 

 

By changing the factory setting, the COM1 port may be converted into an RS485 serial port. This is to be 

ordered at the same time as ordering the equipment. The COM1 (RS485) pinout is as follows: 

 

Pin Function 

1 – 3 
(TX/RX +) Differential input/output + (bidirectional). 

Positive polarity with regards to pins 2 – 4 for one MARK. 

2– 4 
(TX/RX –) Differential input/output – (bidirectional). 

Negative polarity with regards to pins 1– 3 for one MARK. 

5 (GND) Non isolated ground. 

6 Not connected. 

7 – 8 (GND) Non isolated ground. 

9 +5 V (not used). 

 

 

SW4 Selector switch 1   ON = COM1 RS232 

    OFF= COM1 RS485 

SW4 Selector switches 3 and 4: ON = TERMINATION ON 

  OFF = TERMINATION OFF 

 

 

NOTE 

In order to set the COM1 port to RS485 protocol, besides properly setting 

selector switch SW4, the flat cable supplied with the board shall be connected to 

connector CN11, which is located next to connector CN3 (the default connector 

for the COM1). Some software parameters are to be changed accordingly 

(please refer to the User Manual of the Data Logger board.) 

 

COM2 Port 

 

The COM2 port in ES851 board acknowledges RS485 standard only, but it may acknowledge the Profibus 

protocol as well. The COM2 port pinout is as follows: 

 

Pin Function 

1 – 2 Not connected 

3 (TX/RX +) Differential input/output + (bidirectional). 

4 Profibus RTS 

5 (GND) Isolated signal ground 

6 +5V 

7 Not connected 

8 (TX/RX –) Differential input/output – (bidirectional). 

9 Not connected 

 

SW2 Selector switches 3 and 4: ON = TERMINATION ON 

  OFF = TERMINATION OFF 

 

 

ETHERNET 

 

It is possible to connect the Data Logger in local mode via the Ethernet port of the Data Logger by means of a 

cross-over Ethernet cable. The default IP address of the Data Logger board is 192.168.0.2. 

 

 

CAUTION 

The master Modbus mode is the default mode for the COM2-RS485 port for the 

Sunway M XR, Sunway M PLUS and Sunway TG inverters. Consequently, the relevant 

parameter is to be changed accordingly (see the Programming Instructions manual of 

the Data Logger board) in order to be connected in slave mode. 
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3.2.2. REMOTE CONNECTIONS 

 

The Data Logger board makes it possible to connect the inverter to the plant in remote mode even when just 

one PC is used. 

The available connecting modes are as follows: 

 

1. Modem (Analogue or GSM)  

2. LAN and VPN-LAN 

3. Internet-Proxy 

 

MODEM 

 

The Data Logger board is to be connected through RS232 port to a GSM modem or an Analogue modem by 

means of a non-crossed RS232 cable. The board is to be correctly programmed. 

The remote computer can be connected via modem to the plant (by means of an analogue or GSM modem) 

in Rem(Master) /Client mode as described in Connection via Modem and via the LAN. 

 

LAN or VPN-LAN 

 

By using the Ethernet port of the Data Logger and a non-crossed Ethernet cable it is possible to connect the 

plant to a LAN. A static IP address and the LAN gateway are required. 

The remote computer may access the Data Logger board by connecting in Rem(Master) /Client mode as 

described in Connection via Modem and via the LAN. The remote computer is to be connected to the same 

LAN of the Data Logger board, both directly and via VPN. 

 

INTERNET-PROXY 

 

If the link.elettronicasanterno.it has been acquired, it is possible to connect the ES851 Data Logger board to a 

computer in Rem(Master)/Client Proxy mode via the Internet, as described in Connection via Modem and via 

the LAN. 
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3.3. Connection Kits and Accessories 

 

 

3.3.1. DCS770  - USB/RS485  CONVERTER 

 

RS485-side, extractable screwable terminal board. 

This converter is used when your PC is provided with a USB port. 

 

 

NOTE 
When using this type of converter, a software application is to be installed (see the 

Installing the RS485/USB Converter section). 

 

 

 

RS485-side Terminals 

- + GND 

D0 D1 C 
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3.3.2.  DIGITUS  -  USB/RS232  CONVERTER 

 

RS232-side, male D9 converter; its pin-out complies with the RS232 standard. 

If the plant is equipped with an ES851 Data Logger, its COM1 port (RS232 port) can be used. If the computer 

is not provided with the RS232 port, the USB/RS232 converter must be used. 

 

 

CAUTION 

RS232 connection is recommended for cable paths shorter than 2 m. For longer 

paths, RS485 links are recommended. For ES851 Data Logger, the COM1 port 

can be converted into an RS485 port (this is to be stated when ordering the 

equipment). 

 

 

NOTE 
When using this type of converter, a software application is to be installed (see the 

Installing the RS232/USB Converter section). 

 

 

 

 

 

NOTE 
ES851 Data Logger allows the local connection to a computer through the 

Ethernet port and a cross-over cable. 
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3.3.3. LED DISPLAY (LUMINOUS PANEL) 

 

The PC can be connected also to a Led display (or luminous panel) to view the values of the variables detected 

from the plant. The LED display is provided with an RS485 cable equipped with a D9 connector. The pin-out 

of the D9 connector is the following: 

 

RS485 

RX/TX  

A+ 

NC NC NC NC NC NC NC 

RS485 

RX/TX  

B- 

01 02 03 04 05 06 07 08 09 

 

If the PC is not provided with any RS485 port, the same converter as described in Connection Kits and 

Accessories is to be used, depending on the port provided on the PC (USB or RS232 port). 
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3.4. Warnings Concerning RS485 Connection 

 

 

NOTE 

If diverse devices are linked to the RS485 network, make sure that all communications 

parameters are set up with the same Baudrate, Parity, Stop Bit N. You can refer to the 

respective manuals of the connected devices. 

 

NOTE 

Connect the corresponding terminals to each other when connecting slave devices to the 

communications master device; refer to the signal polarity, as the terminals of the 

connected devices are not uniquely identified.   

 NOTE 

Connecting the common terminal is not required. 

However, make sure that the common conductors (0V) for all the devices in the 

communications multidrop network are connected to each other. This minimizes any 

difference of reference potential among the devices that can adversely affect 

communications. 

 

Wiring Cable 

Type of cable 
Screened cable composed of balanced D1/D0 pair + common conductor 

(“Common”). 

Min. cross-section of the 

conductors 

AWG24 corresponding to 0.25 sqmm. For long cable length, larger cross-

sections up to 0.75 sq mm are recommended. 

Recommended max. length 
500 metres if compared to the max. distance measured between any two 

stations. 

Characteristic impedance Better if exceeding 100 (120 is typically recommended).  

Standard colours Yellow/brown for D1/D0 pair, grey for “Common” signal. 

 

The type of cable recommended for those applications is “Belden 3106°” (distributed by Cavitec). 

 

 

NOTE 

When multiple devices are connected to the same RS485 multidrop network, it is 

recommended that the line terminator and the bias of the farthest device from the 

master computer be activated. 

On the other hand, it is recommended that the line terminator and the bias of the 

intermediate devices be deactivated. 

 

NOTE 

Communication does not take place or is adversely affected if multidrop 

terminators are not properly set up, especially in case of high baud rate. If more 

than two terminators are fitted, some drivers can enter the protection mode due to 

thermal overload, thus stopping communicating with some of the connected 

devices. 
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4. INSTALLING  THE SOFTWARE 

4.1. Installing the RS485/USB Converter 

 

Insert the USB connector into the USB port in your computer. In “Device Manager” (in “Control Panel”), check 

the number of the serial port where the device has been installed (COMxy). 

 

 

 

If no “USB Serial Port” is available, you must install the driver for the RS485/USB connector. 

Remove the USB connector from the USB port in your computer. Insert the CD-ROM supplied. 

 

 

 

 

 

Select “MekuWin Configuration Program” and click “FTDI USB Drivers”. 
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Click OK to finish the installation of the FTDI USB Drivers. In “Device Manager” (in “Control Panel”), check the 

number of the serial port where  the device has been installed (COMxy). 
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4.2. Installing the RS232/USB Converter 

 

If an RS232 serial port must be used, but this is not available on your computer, install the Driver of the 

RS232/USB converter using the CD-ROM supplied. 

 

Insert the USB connector into the USB port in your computer. The following window appears: 

 

 

 

Select No, not this time and press Next. 
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Choose the automatic setup and press Next. 
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When the “Files Needed” window appears, select the same file as in the figure below: 
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Press Open to complete the installation. Press Finish. 

 

 

 

In “Device Manager” (in “Control Panel”), check the number of the serial port where the device has been 

installed (COMxy). 
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4.3. Configuring Energy Saving Options for your 

Computer 

 

The most advanced operating systems allow the optimization of energy saving for a PC and the connected 

monitor. When selected, however, the options for energy saving can adversely affect the operation of the 

Remote Sunway application. 

From “Settings”, “Control Panel”, select “Energy Saving”. 

 

 

 

 

 

Select “Turn Off Hard Disk- Never” 

Select “Turn off Monitor - Never” to constantly display the status of the system being monitored. 
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4.4. Installing the Remote Sunway 

 

Insert the CD-ROM containing the Remote Sunway application. 

To install the program, click the “RemoteSunwaySetup” icon and follow the instructions given. 

 

 

 

 

 

NOTE 
The standard installation location is  

C:\Programs\ESanterno\RemoteSunway\ 

 



REMOTE SUNWAY 
 

 

INSTALLATION INSTRUCTIONS  

 

28/105 

 

Create the icon on the desktop to quickly start the Remote Sunway.   

Right-click the icon for the Remote Sunway to open the drop-down menu; select “Create Shortcut”. Drag the 

“Shortcut to Remote Sunway” icon to the desktop. 
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From the “Upgrades\Devices” folder (if available) in your CD, copy the *.CSV files to the following folder: 

“C:\Programs\ESanterno\RemoteSunway\devices”. 

 

 

 

The configuration files for the devices connected to the supervisor system are the following: 

 

SMXXXX: Sunway M XR 

STXXXX : Sunway TG 

QFXXXX : Smart String Box 

DLXXXX: Data Logger 

 

If no configuration file for the connected device is available on the CD, please contact Enertronica Santerno 

S.p.A., or download the configuration files from santerno.com. 

 

From the “Upgrades\projects\classes\solar” folder (if available on the CD), copy the available projects to the 

following folder:  

C:\Programs\ESanterno\RemoteSunway\projects\classes\solar\  

 

 

 

“Projects” are plant configuration files, i.e. they contain information about the devices connected to the 

photovoltaic plant to be monitored. 

If the project required is not available on the CD, please contact Enertronica Santerno S.p.A., or download it 

from santerno.com. 

 

http://santerno.com/
http://santerno.com/


INSTALLATION INSTRUCTIONS  

 

REMOTE SUNWAY  

 

31/105 

 

4.5. Auto Start 

 

If no UPS is used for the power supply of your computer (although using a UPS is always recommended), the 

supervisor system will stop (along with your computer) whenever a power failure occurs. Nevertheless, the 

Remote Sunway can be restarted from the operating system of your computer. 

Create a new shortcut to the Remote Sunway (see instructions above). 

Right-click Start and select Open. 

 

 

 

 

 

The Start Menu is displayed: 

 

 

 

 

 

Open the Programs folder; the Startup folder is now available. 

Move the “Shortcut to RemoteSunway” to the Startup folder. 
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5. STARTING  AND CONFIGURING  THE PROGRAM 

5.1. First Start 

 

 

NOTE 
Starting from software version 2.12, the installation CD into the CD player is no 

longer required for the correct operation of the supervisor. 

 

NOTE 
Before starting the Remote Sunway, set up different addresses for all the devices 

to be monitored (see respective manuals). 

 

 

Start the “Remote Sunway” by clicking the “Remote Sunway” icon you have just created. 

 

 

 

Italian is the default dialogue language. Select a flag and click  for a different dialogue language. 
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The Connection selection window appears, allowing configuring the type of connection. 

 

 

 

 

Click  to continue. 
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5.2. Dedicated Project 

 

After the Connection Selection window, the Main window is displayed, allowing performing most of the 

Remote Sunway’s functions. 

 

If you want to use a dedicated project or a preset project, or if you want to restore a previous configuration of 

the Remote Sunway, load the project suitable for your application (single or double inverter, single-phase or 

three-phase inverter, etc.) from the Main window. 

 

 

 

 

 

The standard search path is Projects\Classes\Solar. 

 

When loading a project, the connection parameters might be different from the ones required (.e.g.: type of 

connection, PC port, etc). After loading a project, check and change the connection parameters, if required. 

To do so, press  to go back to the Connection selection window for the correct connection 

configuration. 
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5.3. Configuring the Connection to the Local PC  

 

This configuration allows a supervisor computer to be connected directly to the devices in the photovoltaic 

plant for on-line display and data logging. 

 

• Simple plant (with no ES851 Data Logger board) 
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• Complex plant (provided with ES851 Data Logger)  
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5.3.1. CONFIGURING THE CONNECTION TO THE DEVICES 

 

 

 

 

Return to the Connection selection window. From the Connection Parameters window, select the Local Mode. 

The Serial configuration parameters tab contains the parameters required for the configuration of the serial 

port of your computer connected to the device in Local and Slave mode. 

 

Device port 

1. RS232 3-wire RS232C standard is used. 

2. USB-RS232 RS232C protocol using a USB port of the computer through a USB/RS232 adapter box is 

used. 

3. RS232-RS42 (4-wire) 4-wire RS422 protocol is used; can be supported through an RS232/422 

adapter box. The link is controlled by the RTS signal. 

4. USB-RS422 (4-wire) 4-wire RS422 protocol is used, using a USB port of the computer through a 

USB/RS422 adapter box. 

5. RS232-RS485 (2-wire)  

not supported 

6. USB-RS485 (2-wire) 2-wire RS485 is used, using a USB port of the computer through a USB/RS485 

adapter box. 

PC Port  

Serial port of your computer where the device is connected to (enter the number of the serial port allocated to 

the device when installing the converter). 

Baud Rate 

Baud rate of the serial port. It must be the same as the baud rate selected for the connected device. 

Parity 

Defines the parity bits. It must be the same as the parity selected for the connected device. 

R-I Minimum Delay 

Minimum delay between a response and a new query. It is expressed in ms and is the waiting time between 

the last response received by the device and a new query sent from the computer. It is required when using the 

RS485 protocol and when the connected device engages the bus for a time longer than the time required for 

data transfer. 

Timeout 

Timeout period allowed between a query from the computer and the response of the connected device. When 

the preset timeout period is exceeded, a warning message is displayed.  
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Scan Timeout 

Timeout period allowed between a query from the computer and the response of the connected device when 

scanning the devices connected to the same network.  

 

Enter the number of the COM port (COM xy) of the PC being used. You can obtain the number of the Com 

port from “Device Manager” (in “Control Panel”). 

Enter the number of the converter being used (e.g. 2-wire USB-RS485). 

If the devices connected to the supervisor systems are all inverters (both Sunway TG and Sunway M XR 

inverters), do not alter the data set in “Baud Rate 38400”; if not, adjust the baud rate to the slowest device. 
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5.3.2. THE LED  DISPLAY (LUMINOUS PANEL) 

 

When the supervisor computer is persistently connected to the photovoltaic plant, a LED display (luminous 

panel) can be used to view some important variables. 

The supervisor computer must be provided with an additional RS485 link, separate from the link dedicated to 

the acquisition of the devices included in the PC plant. The additional RS485 link can be obtained by 

converting an available serial link or USB port using the dedicated converter. 

 

Return to the Connection Selection window and click the Luminous Panel Serial Link tab to configure the 

correct connection between the Remote Sunway and the luminous panel. 

 

 

 

 

 

Set up the parameters required for configuring the serial port of the supervisor computer connected to the 

luminous panel. 

 

Protocol 

Allows selecting the driver to be used for the luminous panel. The driver consists of DLL files; the filenames 

include the model of luminous panel being used and contained in the “LedPanelsDLL” folder 

(Walldisplay_TOTEM_RS485_CRC is selected by default).  

 

 

NOTE If the luminous panel is not used, set None for the “Protocol” drop-down box. 

 

Port 

Serial port of the PC where the luminous panel is connected to. 

Baud Rate 

Baud rate of the serial port; it must be the same as the baud rate selected for the luminous panel. The default 

baud rate is 9600. 

Parity 

The parity bit must be the same as the parity bit selected for the luminous panel (the default setting is pNone). 

Stop Bit  

N. of stop bits. The default setting is 1. 

Character N. per Line 

Maximum number of characters per line allowed by the luminous panel. 
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5.4. Configuring the Remote Connection (PC to PC) 

 

The configuration shown below allows a supervisor computer to be connected directly to the devices included 

in the PV plant for on-line display and data logging, as well as the remote connection of a computer offering 

the same display functionality. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Remote Sunway must be correctly configured for both the SERVER (Local PC) and the CLIENT (Remote PC). 
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5.4.1. CONNECTION VIA THE INTERNET 

 

The connection via the Internet between two computers is possible using the link.elettronicasanterno.it service 

offered by the Proxy-server system from Enertronica Santerno S.p.A.. 

Thanks to this service, a remote PC can be connected to a local supervisor computer of the plant at any time 

and from any place, even if its IP address is not known. The link.elettronicasanterno.it service also offers 

automatic services for supervision and remote control allowing notifying the plant status via mail or SMS. 

 

5.4.1.1.  PLANT  SUPERVISOR  COMPUTER–ESPROXY SERVER 

 

In the Connection selection window of the Remote Sunway implemented on the SERVER PC (local supervisor 

computer of the plant), set the following items: 

Mode: Rem (Slave); Type of connection: ESProxy Server. 

The RemoteSunway automatically sets up the TCP/IP Port and the Remote Host for the connection to 

link.elettronicasanterno.it. 

 

 

 

A tab appears, that must be filled in. The mandatory fields are marked with (*). 

 

Please refer to the Configuring the Connection to the Local PC section for the setting of the connections to the 

devices (Serial Link tab) and the LED display (Luminous Panel Serial Link) and enter the same settings. 

 

In the ES Proxy settings tab, enter the time interval the Remote Sunway requires to communicate its status to 

link.elettronicasanterno.it. 

Also enter the Username and Password of the Internet account provided from Enertronica Santerno S.p.A. and 

which identifies the implemented Remote Sunway. 

 

 

CAUTION 
The Remote Sunway is case-sensitive. Pay attention when entering your username 

and password. 

 

 

NOTE 
The remote client PC shall be capable of establishing a connection to the Internet; 

no specific protocols are required. 

 

Click Enable to establish a connection and to send enquiries to the connected devices. 

 

5.4.1.2.  REMOTE PC–  CLIENT  ESPROXY  
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In the Connection selection window of the RemoteSunway implemented on the CLIENT PC (remote PC), set the 

following items: 

Mode: Rem (Slave); Type of connection: ESProxy Client. 

The RemoteSunway automatically sets up the TCP/IP Port and the Remote Host for the connection to 

link.elettronicasanterno.it. 

 

 

 

A tab appears, that must be filled in. The mandatory fields are marked with (*). 

 

In the ES Proxy settings tab, enter the Username and Password of the Internet account provided from 

Enertronica Santerno S.p.A.. In the Device MAC Address field, enter the MAC address of the computer or of 

the ES851 Data Logger you are connecting to. If the MAC address of ES851 is not known, press the List button 

to view the available boards (see the Device List Window section below). 

 

Press the Connect button to establish the connection to the local supervisor computer of the plant (PC server). 

 

It is now possible to operate on the devices connected to the control power unit. 

 

 

NOTE A LED display (luminous panel) can be connected also to the remote client PC. 

 

 

NOTE 
The PC shall be capable of establishing a connection to the Internet; no specific 

protocols are required. 
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5.4.1.3.  DEVICE L IST W INDOW 

 

 

 

This window shows the whole list of the devices assigned to the user set in Username and Password in the 

ESProxy Configuration window in Master-ESProxy Client mode. A device can be an ES851 Data Logger board 

or a computer where the Remote Sunway is configured as ESProxy Server Slave. 

The following items are provided: 

 

• MAC:  MAC address of the device. 

• Alias:  Description of the device. The “link.elettronicasanterno.it” service provides a default description 

for each device. To edit this description, see the Change Device Alias Window. 

• Status: Lists the different errors and states of the device. If this line is highlighted, errors and states are 

reproduced in the “Status:” box below the table. 

• Time(m): Time (in minutes) elapsed from the last status message sent from the device. 

 

List button 

If you press the List button, the portal refreshes the device list and the new list is displayed. 

 

 

NOTE Enter the correct username and password to correctly execute this command. 

 

OK button 

This button allows copying—in the Device MAC Address box (ESProxy Configuration window)—the MAC 

address of the device selected in the list and closes the Device List window. 

 

Cancel button 

Closes the window.  

 

Change Alias button 

Opens the window allowing change the device alias (see the Change Device Alias Window). 
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5.4.1.4.  CHANGE DEVICE ALIAS W INDOW 

 

 

 

This window allows changing the alias assigned to each device. It provides a blank line for each device where 

you can add comments for the device identification. 

Press OK to confirm changes. Any changes will be saved to the “boardsalias.txt” file in the Remote Sunway 

folder. 

 

 

NOTE 

The link.elettronicasanterno.it service provides a Default Alias list which is 

automatically displayed and which can be changed from the Change device alias 

window. 
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5.4.2. CONNECTION VIA MODEM AND THE LAN 

 

When using a LAN connection or a modem point-to-point connection, the master PC and the slave PC can be 

connected as described in the sections below. 

 

5.4.2.1.  PLANT  SUPERVISOR  COMPUTER  -  SERVER 

 

In the Connection selection window in the Remote Sunway implemented on the SERVER PC (local supervisor 

computer of the plant), set the following items: 

Mode: Rem (Slave); Type of connection: Server. 

Set the device Port based on the connection selected and set the correct serial port of the PC. Baud rate and 

Parity must match with the values set for the connected devices. 

 

 

 

A tab appears, that must be filled in. The mandatory fields are marked with (*). 

 

The connections to the devices in the plant (Serial configuration parameters tab) and to the luminous panel 

(Luminous panel serial link tab) are configured as stated in the Configuring the Connection to the Local PC 

section. 

 

Based on the type of remote connection being used (connection via modem or the LAN), some dedicated tasks 

might be required: 

 

Modem connection between the remote PC and the Local PC: the local PC shall be ready to receive incoming 

connections. 

 

 

NOTE 
To create the incoming connection, use the Windows utilities for networking. See the 

Configuring the Operating System for Point-to-Point Connections. 

 

Connection via the LAN between the remote PC and the Local PC: No additional operation is required. 



INSTALLATION INSTRUCTIONS  

 

REMOTE SUNWAY  

 

47/105 

 

Click Enable to start the connection and to query the devices. 

 

 

 

Check the local IP address (a STATIC IP Address is required for persistent connections) and the TCP/IP Port 

being used. The CLIENT PC needs this data to establish a connection. 
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5.4.2.2.  REMOTE  PC  -  CLIENT 

 

In the Connection selection window of the Remote Sunway for the CLIENT PC (Remote PC), set the following 

items: 

Mode: Rem (Master); Type of connection: Client. 

 

 

 

Fill in the Operator Sheet: 

 

 

 

Based on the type of remote connection (via modem or via the LAN), some dedicated tasks might be required: 

 

Modem connection between the Remote PC and the Local PC: without quitting the Remote Sunway, establish 

the point-to-point connection, or select the desired modem connection from the “First Connect to” option. In 

Rem. TimeOut, increase the delay time (10 seconds if you are connecting to a GSM modem, 5 seconds if you 

are connecting to an analogue modem). 

 

 

NOTE 
The point-to-point connection can be created from the Remote Sunway using 

the ““First Connect to” Option. 

 

Connection via the LAN between the Remote PC and the Local PC: No additional operation is required. 
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For any type of connection (via Internet, LAN, modem), the Remote HOST and the TCP/IP Port must be set up 

accordingly. 

In Rem. Host, enter the IP address of the server PC (local supervisor computer of the plant); in TCP/IP Port, 

enter the same TCP/IP Port used from the server. 

 

 

 

 

Click “Connect” to establish a connection with the server. 

It is now possible to operate on the connected devices. 

 

 

NOTE A LED display can be connected to the Remote PC as well. 

 

 

5.4.2.3.  “F IRST CONNECT TO”  OPTION  

 

If the “First connect to” box is selected, press the “Connect” button to automatically establish the selected 

remote connection, thus avoiding activating any connections manually from Windows. 

 

 

 

The  button allows accessing a menu to create a remote connection. See the Windows XP and Windows 

2000 section. 
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5.5. Configuring a Remote Connection between a PC 

and ES851 Data Logger 

 

ES851 Data Logger is installed on one of the connected inverters (a single-phase or a three-phase inverter) 

forming the photovoltaic plant. All the remaining devices can be connected directly to ES851 Data Logger 

board. This configuration allows the remote connection of a computer to view the plant conditions on-line and 

to retrieve stored data.  
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5.5.1. CONNECTION VIA THE INTERNET 

5.5.1.1.  REMOTE PC  –  ESPROXY CLIENT  

 

In the Connection selection window of the Remote Sunway implemented in the Remote CLIENT PC set the 

following items: 

Mode: Rem (Master); Type of connection: ESProxy Client. 

The Remote Sunway automatically sets the TCP/IP port and the Remote Host for the connection to 

link.elettronicasanterno.it. 

 

 

 

A tab appears, that must be filled in. The mandatory fields are marked with (*). 

 

In the ES Proxy settings tab, enter the Username and Password of the Internet account provided from 

Enertronica Santerno S.p.A.. In the Device MAC address field, enter the MAC address of the ES851 Data 

Logger you are connecting to. If the MAC address of ES851 is not known, press the List button to view the 

available boards (see the Device List Window section). 

 

Press the Connect button to establish the connection to the selected ES851 Data Logger. 

 

It is now possible to operate on the devices connected to the control power unit. 

 

 

NOTE A LED display (luminous panel) can be connected to the remote client PC as well. 

 

 

NOTE 
The remote client PC shall be capable of establishing a connection to the Internet; 

no specific protocols are required. 
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5.5.1.2.  DEVICE L IST W INDOW 

 

 

 

This window shows the whole list of the devices assigned to the user and set in Username and Password in the 

ESProxy Configuration window in Master-ESProxy Client mode. A device can be an ES851 Data Logger board 

or a computer where the Remote Sunway is configured as ESProxy Server Slave. 

The following items are provided: 

 

• MAC:  MAC address of the device. 

• Alias:  Description of the device. The “link.elettronicasanterno.it” service provides a default description 

for each device. To edit this description, see the Change Device Alias Window. 

• Status: Lists the different errors and states of the device. If this line is highlighted, errors and states are 

reproduced in the “Status:” box below the table. 

• Time(m): Time (in minutes) elapsed from the last status message sent from the device. 

 

List button 

If you press the List button, the portal refreshes the device list and the new list is displayed. 

 

 

NOTE Enter the correct username and password to correctly execute this command. 

 

OK button 

This button allows copying—in the Device MAC Address box (ESProxy Configuration window)—the MAC 

address of the device selected in the list and closes the Device List window. 

 

Cancel button 

Closes the window.  

 

Change Alias button 

Allows opening the window to change the device alias (see the Change Device Alias Window). 
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5.5.1.3.  CHANGE DEVICE ALIAS W INDOW  

 

 

 

 

This window allows changing the alias assigned to each device. It provides a blank line for each device where 

you can add comments for the device identification. 

Press OK to confirm changes. Any changes will be saved to the “boardsalias.txt” file in the Remote Sunway 

folder. 

 

 

NOTE 

The link.elettronicasanterno.it service provides a Default Alias list which is 

automatically displayed and which can be changed from the Change device alias 

window. 
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5.5.2. CONNECTION VIA MODEM AND VIA THE LAN 

 

A remote connection to a PC can be established when ES851 Data Logger board is connected to a LAN or to 

an analogue modem or to a GSM modem for point-to-point connections. To do so, the Remote Sunway is to 

be configured as described below.  

 

 

5.5.2.1.  REMOTE PC  -  CLIENT  

In the Connection Selection window of the Remote Sunway implemented on the remote CLIENT PC, set the 

following items: 

Mode: Rem (Master); Type of connection: Client. 

 

 

 

Fill in the Operator Sheet: 

 

 

 

Based on the type of remote connection (via modem or LAN), some dedicated tasks might be required: 

 

Modem connection between the Remote PC and ES851 Data Logger: without quitting the Remote Sunway, 

establish a point-to-point connection, or select the desired Internet connection from the “First Connect to” 

option. In Rem. TimeOut, increase the delay time (10 seconds if you are connecting to a GSM modem, 5 

seconds if you are connecting to an analogue modem). 

In Host rem., if the “First Connect to” option is selected, “10.0.0.1” is automatically selected. This is the default 

address for connections via modem for the plants where ES851 Data Logger is installed. 

 

 

NOTE 

You can create a point-to-point connection from the Remote Sunway using the 

“First Connect to” option. Refer to the Windows XP and Windows 2000 

section. 

 

Connection via LAN between the Remote PC and ES851 Data Logger: No additional operation is required. 
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In Rem. Host, enter the IP address of ES851 Data Logger you are connecting to: 

• For connections via modem, enter “10.0.0.1”, which is the correct IP address for point-to-point connections 

via modem. If you selected the “First Connect to” option, “10.0.0.1” is automatically set up. 

• For connections via the LAN, enter the address assigned to ES851 Data Logger and provided from 

your network administrator. 

 

 

NOTE The same IP address must be set up for ES851 Data Logger. 

 

In TCP/IP Port, enter the same TCP/IP port used from ES851 Data Logger:  the default setting is Service1 

(6767). 

 

 

 

Click “Connect” to establish a connection with ES851 Data Logger. 

It is now possible to operate on the connected devices. 

 

 

NOTE A LED display (luminous panel) can be connected to the remote client PC as well. 

 

5.5.2.2.  “F IRST CONNECT TO”  OPTION  

If the “First connect to” box is selected, press the “Connect” button to automatically establish the selected 

remote connection, thus avoiding activating any connections manually from Windows. 

 

 

 

The  button allows accessing a menu to create a remote connection. See the Windows XP and Windows 

2000 section. 
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5.6. Configuring the Operating System for Point-to-

Point Connections  

 

5.6.1. CLIENT 

When using remote connections where the computer implementing the Remote Sunway programmed as a 

client is not connected to a LAN, you have to create an outgoing connection (Client connection) allowing the 

operating system to establish a connection to an ES851 Data Logger or to a computer implementing the 

Remote Sunway programmed as a server. 

 

5.6.1.1.  W INDOWS XP  AND WINDOWS 2000 

When using Win2000 and WinXP, you can connect the client to an XP server or an ES851 Data Logger by 

selecting the “First Connect to” option and the  button. This allows displaying the Remote Access 

Configuration window directly from the Remote Sunway. Also, you can use the same connecting procedure 

allowing connecting to the Internet via analogue modem without changing the default settings of the operating 

system. 

Your username and password must be the same as those you entered for your account authorizing dial-in for 

the server PC or ES851 Data Logger. 

 

 

NOTE If you are asked to enter the domain name, leave blank. 

 

 

 

The Remote Access Configuration window is a simplified interface for the Windows Network Connections 

window. 

For each connection, you can set and alter the following items: Username, Password, Phone Number.  

Use the Call->Dial command to test the selected connection. 

 

 

 

From the Connection List menu, use the Connection List->New Connection to create additional connections, 

as this function automatically recalls the utilities of the operating system to create a new connection. 
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You can also alter advanced connection parameters using the Connection List->Change Connection command.  

 

 

 

 

Fill in all the fields in the “Remote Access Configuration” window (enter the same data items as those entered 

for the Server; also enter the phone number). 
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5.6.1.2.  W INDOWS V ISTA 

The connection to a client PC implementing Windows Vista is the same as an Internet connection via analogue 

modem. The default settings of the operating system are to be left unchanged. 

The username and password must be the same as the ones used for an account authorized to receive 

incoming calls to the server computer or to ES851 Data Logger. 

 

 

NOTE If you are asked to enter the domain name, leave blank. 

 

5.6.2. SERVER 

For point-to-point connections via modem between two computers, an incoming connection is required in the 

computer implementing the Remote Sunway programmed as a Server. The incoming connection allows the 

Remote Sunway to accept the calls performed by the computer implementing the Remote Sunway 

programmed as a client. To create an incoming connection, you can exploit the utilities of the operating 

system. 

 

Below is an example of how to accept incoming connections in Windows XP. 

 

From the Start menu, choose: 

 

 
  

To open the “My Network Places” window, create a new connection: 
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Select “Set up and advanced connection”: 
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and select “Accept incoming connections”: 

 

 
 

Select a modem for incoming calls: 

 

 



REMOTE SUNWAY 
 

 

INSTALLATION INSTRUCTIONS  

 

62/105 

 

 

 

Select or add the user the Client computer shall connect to. If no authorized user is selected, no incoming 

connection is available.  
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In the “Networking Software” section, no changes are needed, as the default settings are sufficient for 

incoming connections. 
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In “My Network Places”, the following icon appears: this indicates that the computer can now receive incoming 

calls. 

 

 

 

When an incoming connection is active, an icon showing the name of the connected user appears: 

 

 

 

 

NOTE 
In Windows 2000 operating system, only one window for the network connection 

wizard is available; the incoming connection is then selected from that window. 
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5.7. Automatic Selection of the Connected Devices  

 

Once a connection has been selected from the Connection selection window, click “Connect” to establish a 

connection. 

 

Click Next to access the Main Window of the Remote Sunway, where you can access all menus and 

create/handle the projects for the photovoltaic plants. 

 

If no project fitting the plant requirements is included in the installation CD-ROM for the Remote Sunway, a 

special project is to be created.  

 

To do so, open a New Project by clicking the icon highlighted in the picture below, or select “Open” from the 

File  menu. 

 

 

 

 

 

The Device Type Selection window appears, allowing the connected devices to be automatically detected by 

the Remote Sunway. First set up the Start address and the Stop address for the address range to be scanned, 

then click “Scan” to initiate automatic scanning. 
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Select the detected devices one by one from the “Network” section, then click “Add”. 

 

 

 

Once you have added all the detected devices one by one, click “Close”. 

 

5.7.1. MULTIREAD OPTION 

 

The Multiread option is activated ONLY when a remote connection is established to a PC and to ES851 Data 

Logger board. This option allows multiple readout events by sending just one remote request. As a result, the 

read rate of parameter sets is dramatically increased when the remote connection is particularly slow. 

The enable/disable status of the Multiread option can be viewed from the main window.  

 

 

 

 

 

CAUTION 

When a remote connection is established to a Data Logger ES851 board with 

software versions DL 160x or DL 165x, or to the Remote Sunway with software 

versions 2.01, 2.12 or 2.13, the Multiread option MUST be disabled because it is 

not supported. If not, the automatic/manual selection of the connected devices 

and the readout from the devices included in a project is inhibited. 

 

Always check the software version of ES851 Data Logger board and of the Remote Sunway you are connecting 

to. When software versions are implemented, that do not support the Multiread option (as stated in the 

“CAUTION” box above), make sure that the Multiread option is DISABLED. 

To do so, open the Option window from the Config menu. 
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Disable the Multiread option. 
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5.8. Manual Selection of the Connected Devices  

 

This function allows the devices that do not support the automatic detection function to be integrated into the 

supervisor system. 

The devices that can be added to the supervisor system are String Boxes up to 8 inputs. More complex string 

boxes are obtained by combining basic string boxes; 16-input string boxes are considered as two separate 

devices and require two different addresses. 

 

To open the Device Type Selection window, click the Add New Device icon (highlighted in the picture below) 

from the Main Window, or select the “Add New Device” option from the File menu. 

 

 

 

 

 

Access the manual selection by clicking the Type of device drop-down box. Select the device desired. 
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Enter the same Address as the one set for the remote device, then click “Add”.  

Select one remote device at a time (manually select even the same type of remote devices installed before) and 

enter the respective address for each device. 

Once you have added all the remote devices, click “Close”. 
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5.9. Project Window 

 

The Project Window is divided into two sections. The section on the left is the list box of the system. Click one 

item to select the respective device.  

 

 

 

 

The black boxes identify the address and the device type. 

You can assign an arbitrary name to each device. Right-click the desired device and select Rename. 
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The right portion in the Project Window contains some tabs, which are arranged by device. The tabs for the 

Sunway T are shown below. 

 

 

 

 

 

General Measures: displays all the electric measures available from the inverter; 

Inverter Status: displays the current operating conditions of the inverter, the alarm tripped (if any), the status of 

each digital input in the control board allocated to electromechanical functions; 

Standard Ambient Measures: contain the values of four ambient variables (two values for solar radiation and 

two temperature values) detected by special sensors (if any) connected to the inverter. 
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5.10. Configuring Data View and Acquisition 

 

It is possible to set up the readout, acquisition and automatic graphical representation of the variables 

displayed in the Project window. 

In the available projects, all the electric variables available at the moment (“Auto” checkbox selected) are 

displayed in the “Inverter Measures” panel; on the other hand, some variables have been already selected to 

be acquired as history data (“Acq” box selected).  

In order to add data items to be acquired and saved, select the corresponding “Acq” boxes for each variable. 

 

 

NOTE 
We suggest that “M089 Inverter Status” be acquired in the “Inverter Status” folder 

instead of the “Inverter Measure” folder. 

 

Select the “Gr” checkbox to display an on-line graph representing some particular variables. 
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In the “Inverter Status” folder, the available projects allow the inverter status and alarm tripped (if any) to be 

displayed on-line and to be acquired as history data. 

The “Control Status” (MPPT enabled, etc.) and the electromechanical conditions are viewed on-line. 

 

 

 

 

 

For the “Standard Ambient Measures” tab, no data is expected to be viewed and/or acquired. The user shall 

configure this tab based on the available measures by selecting the “Auto”, “Acq” and—if necessary—”Gr.” 

checkboxes of the channels where a sensor/transducer is connected to. 

 

 

 

 

 

NOTE 
The “Standard Ambient Measures” tab follows the default configuration of the 

“Ambient Measures” menu for the Sunway inverters. 
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Select the “General Acquisition Setting” menu to configure the acquisition times of the selected variables for all 

the  available folders: 

Acquisition Time (1-10sec), 

Average Time (1-30min), 

Save Time (multiple of the Average Time). 

 

Select the “Acq En.” and “Save En.” checkboxes and click “Apply” for each sheet. You can also select some 

adjacent sheets and click “Apply” for all the selected sheets. 

 

 

 

 

 

NOTE 
The average time for the “Inverter Status” tab shall be the same as the sampling 

time. 

 

NOTE 
If no ambient variables are expected to be acquired, do not enable data 

acquisition and save options for the “Standard Ambient Measures” tab. 

 

In the Setting of saving folder field, select the target folder for the files to be saved, as well as the type of Split 

for acquired data. When Monthly is selected, the Remote Sunway will create a new folder every month. This 

folder will contain the data files saved every month (one file per each sheet is created). When Weekly or Daily 

is selected, a folder for each week or day of a given month is created. This folder contains the data files 

relating to a given month or day (one file for each sheet is created). 

In order to save all the sheets, select the Enable saving box and click OK to store the new settings. 
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5.11. Starting Acquisition and Saving Configuration 

 

Select the “EnAcq.Eng.” checkbox. 

 

 

 

 

Acquisition is now started; queries from the PC to the inverter are viewed. This means that communication is in 

progress. 

 

 

 

Save the project to the “Project” window with the Save Project  Save all option from the File Menu. You can 

provide a name to the project (e.g. the plant name). This is required only after creating or changing the 

project. 
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It is recommended that you not overwrite the original project in the “Classes\Solar” folder, thus keeping an 

intact copy to be used in case of incorrect programming. 

 

From the Config  Options menu, check the Reload last project folder to reload and start this project when 

the Remote Sunway is next started. 
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5.12. The ME00X0 Panel and the LED Display 

 

When the photovoltaic plant includes more than one inverter, a special panel is available, providing the values 

of the main variables, such as the overall energy delivered, the overall power in the network, and so on. 

This “virtual” panel is called ME00X0 and consists of configurable measure panels. 

 

Click “Add New Device”. 

 

 

 

 

Manually select ME00X0 and add the default address without making any changes. 

 

 

 

 

The “General Measures” panel is displayed.  

This panel includes several panels that can be thoroughly programmed by the user. Their meanings are 

assigned during factory setting, but can be easily changed. 
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Right-click any measure panel; the button allowing opening the Features panel is displayed. 

 

 

 

Click Features to open the Modify Parameter Features window. 
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All the fields can be changed by the user: 

• Description: Description of the measure. 

• Unit of Meas.: Unit of measure viewed on the panel. 

• Print Size: Measure display; e.g. six digits with one decimal place. 

• Minimum Value and Maximum Value: Range of the measure to be displayed. 

• Formula: This is what is intended to be displayed; the syntax allows matching measures from different 

devices. 

The syntax of the formula contained in the picture above is the following: 

The “#” character is the device separator; ST160X is the type of device viewed in the left column of the 

project window in the Remote Sunway: “:2:” is the address of the device; M003 is the code identifying the 

variable concerned (M003 is the grid power in the example); “#” terminates the description of the first 

variable; “+” is the arithmetical operator (-, *, / operators are also available); you can then add a similar 

expression to retrieve the same variable from a different device. 

More than two operands can be combined. 

The second operand can be a constant to translate a variable (i.e. to translate the overall energy 

produced into the overall CO2 not produced). 

Click OK to quit.  

 

 

 

The “Auto”, “Acq” and “Gr.g checkboxes allow on-line view, acquisition enable and on-line graphic 

representation at the bottom of the screen. 

 

The Led box is to be enabled to publish the measure to an external LED display connected to the PC. See 

The LED Display (Luminous Panel). 

 

Two more steps are to be taken to send more than one measure to the LED display: 

 

• In the Modify parameter features window, enter the Line where the variable is displayed to, and 

the panel Id if two or more panels are present. Also, a Comment can be entered next to the 

description of the measure. 
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NOTE 
When the LED option is enabled, all the measures shall have a different line 

number. 

 

• Select the En.Pan. box (at the bottom of the window) to send the alphanumeric strings to be 

viewed on the LED display. 

The refresh time for the data viewed on the LED display can be changed from the Pan.Refr.T(sec). 

 

 

 

 

CAUTION 
In order to dialog with the Led display, The LED Display (Luminous Panel) window 

must be set up and the “Connect” option in that window must be activated. 
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5.12.1. P_NAME PANEL 

 

 

 

The P_Name panel is used for viewing text strings. Strings can be published to the Led display by enabling the 

LED option.  

 

Right-click the panel. The  function appears. Click this function to display the following window: 

 

 

 

Panel Id 

The same features as “Panel ID“ are implemented for the measure panel with custom properties and output to 

Led display. 

 

Comment 

String displayed on the panel. 

 

Line 

The same features as “Line“ are implemented as for the measure panel with custom properties and output to 

Led display. 

 

 

CAUTION 
The P_Name panel is present in dummy device ME0010. Two additional P_Name 

panels can be added using the New parameter function from the File Menu. 
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5.12.2. STATUS PANEL 

 

 

 

The Status panel monitors the status of one or multiple devices. The figure above, which is given as an 

example, shows the list of the active alarms, along with the equipment identifier, the equipment address, the 

parameter identifier and the string related to the alarm tripped. 

 

 Refreshes the alarms tripped. 

 Cyclically reads the alarm conditions of the equipment. The time interval for cyclic reading is set in 

State Acq Time. 

 Enables the state recording. The actual acquisition will take place only once the recording state has 

changed. The recording state is checked at each time interval specified by State Acq Time. 

To view the measures to be checked, open the Properties window. Right-click the panel; the 

function appears. Left-click this function to display the following window: 

 

 

 

Short description 

Parameter description in the Tree list.  

  

Description 

Parameter description in the panel. 

  

Formula 

String defining the list for the state measures to be checked. 

Syntax: 

<Reference to the state measure><><Numeric value representing the “OK status” condition>, <Reference to 

the state measure><><Numeric value representing the “OK status” condition>...  

 

References to the state measures are to be expressed as follows: 

  

d:a:p, where d specifies the equipment identifier, a specifies the address, and p specifies the parameter 

identifier. 

  

Example:  
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ST169X:2:M090<>0,ST169X:3:M090<>0. 

 

 

NOTE 
The Status panel is present in dummy device ME0010. Two additional Status 

panels can be added using the “New parameter” function from the File Menu. 
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6. DATA PROCESSING 

 

For each analogue variable, real-time display (numeric values or analogue display with a pointer instrument), 

on-line graphic representation (trend), saving to file (log) are possible for a delayed off-line data analysis. 

 

6.1. Real-time Display 

 

If the “Auto” checkbox is selected, the measure of the variable processed by the inverter is displayed in real 

time (otherwise, the corresponding value is not refreshed). 

 

 

 Numeric display 

 

 

 

 Analogue display 

 

 

Numeric display is available for all variables, whereas analogue display is available for the Supplied Active 

Power and the Field Voltage. 

 

 

NOTE 
M011 and M003 refer to the display in the General Measures Menu that can be 

accessed from the display/keypad of the device. 
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6.2. Trend 

 

If the “Gr.” checkbox is selected, you can obtain the on-line graph of the selected variable. 

 

 

 
 

 

Select the “Dis.Graph” checkbox to view the graphic representation window. 

The graph represents all the variables whose “Gr.” checkbox has been selected, but the ordinate represents 

the scale of only one variable. To view the scale of a different variable, point to the relevant numeric field. 
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6.3. Data Log 

 

Data constantly acquired from the supervisor system is logged to the path programmed so far (see the 

Configuring Data View and Acquisition section). 

 

 

 

Log files are *.csv files that can be viewed from Microsoft Excel only. Logs are sorted by monthly folder. 
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Examples of acquired files: 

 

• File: [3]-_(ST169X)Operating_conditions.csv 

 

 

Date: Time: [3]-M089 [3]-M090 

(yyyy/mm/dd) (hh.mm.ss) InvStatus () Alr Code () 

22/02/2008 17.12.00  SB2 INSOL. KO INVERTER OK 

22/02/2008 17.40.11  ALARM 2     A040 User Fault 

22/02/2008 17.40.57   Resetting    INVERTER OK 

22/02/2008 17.41.03  STOP          INVERTER OK 

22/02/2008 17.42.39  PRECHARGE   INVERTER OK 

 

This file contains the sequence of the PV plant events/alarms. 

Note that columns M089 and AL are provided because the following checkboxes are selected in the Inverter 

Status tab: “Acq” for M089-Inverter Status –, AL Alarm tripped. 

 

• File: [3]-_(ST169X)Inverter_measures.csv 

 

Date: Time: [3]-M003 [3]-M010 [3]-M012 

(yyyy/mm/dd) (hh.mm.ss) Pu (kW) Vdc (V) 
Pdc 
(kW) 

22/02/2008 16.51.00 0.2 341 0.3 

22/02/2008 16.51.01 0.2 341 0.3 

22/02/2008 16.51.02 0.2 344 0.3 

22/02/2008 16.51.03 0.2 344 0.3 

22/02/2008 16.51.04 0.2 339 0.3 

22/02/2008 16.51.05 0.2 338 0.3 

22/02/2008 16.51.06 0.2 341 0.3 

22/02/2008 16.51.07 0.2 341 0.3 

22/02/2008 16.51.08 0.2 336 0.3 

22/02/2008 16.51.09 0.2 335 0.3 

22/02/2008 16.51.10 0.2 337 0.3 

 

This file contains sampled and average measures based on the settings in Acquisition General Settings. 

Variables are acquired when their “Acq” checkboxes are selected. 

 

Collected data can be mathematically processed with Microsoft Excel or similar applications. 

 

 

CAUTION 

Do not open those files with Microsoft Excel or other applications when the 

supervisor is operating, in order to avoid any conflicts with the Remote Sunway 

trying to write those files. 

 

NOTE 
The decimal symbol ( “.” or “,”) being used depends on the regional settings of 

your operating system. 
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6.4. Data Logs Acquired from ES851 Data Logger  

 

The Remote Sunway also allows downloading and displaying data stored to ES851 Data Logger board. Log 

files are .csv files. 

 

Once connected to ES851 Data Logger with the connecting modes seen in Configuring a Remote Connection 

between a PC and ES851 Data Logger), open the Project window in the Remote Sunway, click Scan and load 

the DL (Data Logger) device detected in Basic level. 

 

 

 

Select the Upload Console parameter sheet and press ScanLogs to display the status of the logs stored from 

ES851 Data Logger. 
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Select the logs to be downloaded and click the Start button.  

 

 

 

The Remote Sunway asks for generic log filenames. Then, the Remote Sunway will create distinctive logs by 

adding their ordinal number or the Evt acronym as suffixes to their filenames.  

Press Save to start log download. The download procedure can be stopped only by pressing the Stop button;  

any other operation is inhibited. 

 

The history logs can be of two kinds: 

• Measure logs: systematically acquire states and variables relating to the connected devices (e.g. 

logs1.csv) 

 

  D1 D3 D4 D5 D6 D7 

  ST1692[24] ST1692[24] ST1692[24] ST1692[24] ST1692[24] ST1692[24] 

Detection date Detection time Eu00 01 Last Alr Code Vf_Ref R CntMko CntInsKo Terog. 

  M013 FL01 M000 M19 M20 M21 

  (kWh)  (V)   (h) 

        

  
3: Last 
Sample 3: Last Sample 0: Avg 

3: Last 
Sample 

3: Last 
Sample 

3: Last 
Sample 

04/08/2007 23.33.11 3202 A81    5.0 11 4 31.23.48 

04/08/2007 22.33.11 3202 A81    5.0 11 4 31.23.48 

04/08/2007 21.33.11 3202 A81    4.9 11 4 31.23.48 

04/08/2007 20.33.11 3202 A81    4.9 11 4 31.23.48 

04/08/2007 19.33.12 3202 A81  351.2 11 4 31.23.48 

04/08/2007 18.33.12 3199 A81  367.3 11 3 30.33.34 

04/08/2007 17.33.12 3175 A81  417.0 11 3 29.33.33 
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• Event logs: contain recorded events (such as alarms) fired for the connected devices (e.g. LogEvt.csv) 

 

Event 1       

ST1690[2].M0XX Other than INVERTER OK    

Hysteresis = 0      

E1 Detection date 
Detection 
time Event status ST1690[2] ST1690[2] ST1690[2] 

E1    LstAlrm 
01 
InvStatus 01 Pout 

E1    M0XX FL01c FL01s 

E1      (kW) 

E1 19/06/2007 14.49.32 ON A040 User Fault  STOP          0 

E1 19/06/2007 11.00.33 OFF INVERTER OK    RUN         3,2 

E1 18/06/2007 22.25.23 ON A040 User Fault    RUN         3,2 

       

Event 2       

ST1690[3].M0XX Other than INVERTER OK    

Hysteresis = 0      

E2 Detection date 
Detection 
time Event status ST1690[3] ST1690[3] ST1690[3] 

E2    LstAlrm 
01 
InvStatus 01 Pout 

E2    M0XX FL01c FL01s 

E2      (kW) 

E2 18/06/2007 17.17.24 OFF INVERTER OK  STOP          0 

E2 18/06/2007 16.09.24 ON A040 User Fault    RUN         1,3 
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6.5. File Transfer 

 

When a remote connection is established between two computers, files can be transferred from the PC 

connected to the PV plant (Slave PC) to another PC (Master PC). 

To do so, you can use the File Transfer option from the File menu of the Remote Sunway implemented in the 

Master PC.  

 

 

 

Once the connection to the Slave PC is established, select the File Transfer function from the Remote Sunway 

implemented in the Master PC. The window below appears: 

 

 

 

The files and folders of the Master PC and the Slave PC are contained in the left and right box respectively. 

 

 



REMOTE SUNWAY 
 

 

INSTALLATION INSTRUCTIONS  

 

92/105 

 

CAUTION 
The root folder of the path on the Slave computer is the Logs folder within the 

folder where the Remote Sunway is installed. 

 

NOTE Folders cannot yet be transferred. 

 

Select the files to be transferred and press  or  depending on the target folder. 

 

The files selected on the Slave PC can be deleted pressing the  button. 
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6.6. Data Display from the Remote Sunway 

The Remote Sunway is capable of providing a graph for the data that has been previously saved. 

Click “Graph”, then “New Graph”. 

 

 

 

Select the data file to display, for example General Measures Acqs. 
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“Graph Setting” allows changing some properties of the graph, such as the colour of the tracks and the scale 

(it is suggested that variables, such as powers, be the same in the right or left ordinate). 

 

 

 

To display the files that are not graphically represented (such as logsEvt.csv or [3]-

_(ST69X)Operating_conditions), use the Acquired data display table option from the Data menu. 
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7. SCHEDULER 

 

The Scheduler menu allows automating and scheduling the following functions: 

• ES851 log upload. 

• Remote Sunway log upload. 

• Acquisition of a measure set. 

• Publication to the wall display of some measures recorded when using the Acquisition function. 

 

 

 

Programming is configured by composing a tree list of objects implementing special functions. 

The tree list can be saved (click ) to a .sch project that can be automatically reloaded from the Remote 

Sunway when it is restarted and if the Reload latest scheduler option from the Config  Options is activated. 

 

 

 

From the menu bar, select the Scheduler menu. 
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The window below appears: 

 

 

 

First create the Task object before performing any operation with the Scheduler. 
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Use the  button (Add function) to create the Task object. 

 

 

 

The Task object allows programming the function recurrence in the Timing object, which is automatically 

created. 

Recurrence can be: 

▪ “Monthly”  

▪ “Weekly” 

▪ “Daily”  

▪ “Every” (only for data acquire functions) 

 

Point to the Task object and press . The window below appears: 
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From that window, select the type of device (Gateway) you want to establish a connection with: 

 

• RS Gateway: PC implementing the Remote Sunway programmed in Slave mode 

• ES851 Gateway: ES851 Data Logger board. 

 

 

 

 

When adding one of the two Gateways, the Connection object appears, that is to be set up as the Connection 

selection window in the Remote Sunway. This allows the Scheduler to establish a connection to the Gateway. 

 

Point to the Gateway and click ; the window allowing selecting the Scheduler’s functions appears: 

 

 



INSTALLATION INSTRUCTIONS  

 

REMOTE SUNWAY  

 

99/105 

 

7.1. ES851 Log Upload  

 

In order to automatically upload the logs from an ES851 Data Logger board, create a Task with an ES851 

Gateway and add the Upload Logs function as described in the S section. 

 

 

 

When selecting the created object (ES851 Log Upload), the function parameters are viewed in the right box in 

the window. 

Select the Type of device and enter its Modbus Address. 

Select the logs to be uploaded. 

Save the project you have just created and click  to start the Scheduler. 

Once uploaded to the Logs folder in the Remote Sunway,  logs will be sorted in different tree lists.  

 

Example - Tree list of the logs when the recurrence for the Remote Proxy upload is “daily”: 

 

 

NON Proxy connections have a similar structure, except for the <Username> folder, which is not included. 

 

 Proxy-Daily: 

 

user_<username> 

  <board MAC addr.> 

      <year>_<month> 

          dd_<day>   
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7.2. RS Log Upload  

 

The Scheduler is capable of automatically transferring the log files created from a Slave PC (e.g. a local 

supervisor computer of the plant). A Task is to be created with an RS Gateway and the Upload Logs is to be 

added, as described in the S section. 

 

 

 

The figure above shows a Proxy remote connection, where the filename created by the RS Upload object is 

composed as follows: 

 

<MAC of the slave PC>_date_sheet name 

 

For serial links, LAN connections or modem connections (i.e. any type of NON PROXY connections), the right 

box automatically shows the “Slave PC name” box, which allows creating the folder containing the log files. 

For compatibility with Proxy connections, enter the MAC address of the Slave PC preceded by “RS_” as a 

filename. 

 

In the “File folder” case, select the target folder. 

 

When the upload procedure is complete, the logs sorted by tree list will be saved to the Logs folder in the 

Remote Sunway.  

 

Example: Tree list of the logs for Proxy Remote with “daily” recurrence. 

 

 
 

The same structure, except for the <Username> folder, applies to NON Proxy connections: 

 

date_sheet name. 
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7.3. Acquisition 

 

This object allows acquiring some measures from any device connected to a PC implementing the Remote 

Sunway and which is connected in Slave Remote mode (RS Gateway) or to an ES851 Data logger board 

(ES851 Gateway).  

A Task is to be created with an RS Gateway object and the Upload Logs is to be added, as described in the S 

section. 

When selecting Acquisition, the “Acquisition save directory:” field appears in the right box. Select the target 

folder for the acquisition file. 

 

 

 

The figure above shows a Proxy remote connection. The filename created by the Acquisition object is as 

follows: 

 

<board MAC address>_acq  

 

When using a serial link, a LAN or a modem connection (any NON-PROXY connection), the Filename box is 

automatically displayed. In that case, the filename of the Acquisition object is:  

 

<Filename>_acq 

 

Once the acquisition object is added to the list, you have to specify the devices and the relevant measures to 

be acquired. To do so, select the Acquisition object and press the  button (Add function) to open the Select 

measures to add window. 
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Select a device and double-click to display the whole list of the measure sheets. You can select all the sheets to 

acquire any available measure, or you can select only one sheet to choose any single measure.  

 

 

CAUTION 
Before adding measures to the scheduler, set up the Modbus address of the 

selected device. 

 

Click the Add button to add the measures selected in the right box to the list of objects contained in the 

Acquisition object and sorted by measure sheet.  

 

 

 

Do the same for any other acquisition procedure. 
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The acquisition files are sorted in a tree list. 

 

Example: Path of the acquisition file for Proxy Remote connections. 

 

 

user_<username> 

     real_time_data 

 

 

The same structure, except for the <Username> folder, applies to NON Proxy connections. 
 

 

CAUTION 
The file is replaced whenever an acquisition procedure takes place. Appending is 

not supported. 
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7.4. Data Published to the LED Display 

 

The Wall Display object contains the publication activity of the acquired data to the LED display. Publication 

occurs when the Acquisition object contains measures configured for the output to the wall display. For 

example, this kind of measure is contained in the ME00X0 dummy device. 

 

The Acquisition object shall be created (see the Acquisition section), so the ME00X0 dummy device is to be 

selected. The Acquisition object records custom measures. 

When a measure is selected, its custom properties are displayed in the right box in the window. They are very 

similar to the measures described in The ME00X0 Panel and the LED Display. Two additional options are 

included: 

• Persistence (s.):  

Indicates the persistence time (in seconds) of the last valid value read by the Scheduler. When this time 

is over, 0 is displayed on the LED display. 

 

NOTE 

If the persistence time is set to 0, this means that this function is disabled and the 

last valid value read by the Scheduler is kept displayed until it is refreshed (in that 

case, no time limits are provided). 

• Enabled: 

Enables publishing the measure to the wall display. 
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Select the Gateway of the task (ES851 Gateway in the figure below) and click  (Add function) to add the 

Wall Display object.  

This object does not need to be programmed.  Once selected, the right box in the window shows the last string 

published to the wall display. 

 

 

 

 

CAUTION 

In order to dialog with the Led panel, the Luminous Panel Serial Link window must 

be set up and the “Connect” option in that window must be activated. See The 

LED Display (Luminous Panel). 
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